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Trademarks 

Microsoft is a U.S. registered trademark of Microsoft Corporation. 
Windows, Windows XP, Windows Vista, Windows 7 and Windows 8 are either registered 
trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. 
IBM, IBM PC are registered trademarks of International Business Machines Corp. 
Other brands and product names herein are trademarks or registered trademarks of their 
respective holders. 

Copyright 

Copyright© 2014 I.R.I.S All rights reserved.  
 
Information in this document is subject to change without notice. The software described in 
this document is furnished under a license agreement or nondisclosure agreement. 
 
No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval 
system, or translated into any language or computer language, in any form or by any means, 
electronic, mechanical, magnetic, optical, chemical, manual, or otherwise, without the prior 
written permission of I.R.I.S. s.a. 
 
Material scanned by this product may be protected by governmental laws and other 
regulations, such as copyright laws, the customer is solely responsible for complying with all 
such laws and regulations. 

 

Warranty 

The information contained in this document is subject to change without notice. 
 
I.R.I.S. makes no warranty of any kind with regard to this material, including, but not 
limited to, the implied warranties of fitness for a particular purpose. 
 
I.R.I.S. shall not be liable for errors contained herein or for incidental or consequential 
damages in connection with the furnishing, performance, or use of this material.  
 
 

Disposal of Waste Equipment by Users in Private Union 

 

This symbol on the product or on its packaging indicates that the product can not be 
disposed of with your other household waste. Instead it should be sent to appropriate 
facilities for recovery and recycling in an effort to protect human health and the environment. 
Fore more information about where you can drop off your waste equipment for recycling, 
please contact your local city office, your household waste disposal service or the shop where 
you purchased the product.  
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FCC Statement: 
 
This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential installation. This equipment generates, 
uses and can radiate radio frequency energy and, if not installed and used in accordance with 
the instructions, may cause harmful interference to radio communications.  
However, there is no guarantee that interference will not occur in a particular installation. If 
this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one of the following measures: 
 

 Reorient or relocate the receiving antenna. 
 Increase the separation between the equipment and receiver. 
 Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected. 
 Consult the dealer or an experienced radio/TV technician for help. 

 
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired operation. 
 
FCC Caution: 
Any changes or modifications not expressly approved by the party responsible for compliance 
could void the user’s authority to operate this equipment. 
 
This device is intended only for OEM integrators under the following conditions: 
1) The antenna must be installed such that 20 cm is maintained between the antenna and 
users. 
2) The transmitter module may not be co-located with any other transmitter or antenna.  
 
IMPORTANT NOTICE: 
FCC Radiation Exposure Statement: 
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled 
environment. This equipment should be installed and operated with minimum distance 20cm 
between the radiator & your body. To maintain compliance with FCC RF exposure compliance 
requirements, please avoid direct contact to the transmitting antenna during transmitting. 
 
IC Notice: 
Operation is subject to the following two conditions: 
1) This device may not cause interference and 
2) This device must accept any interference, including interference that may cause undesired 
operation of the device. 
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IMPORTANT NOTE: 
IC Radiation Exposure Statement: 
This equipment complies with IC radiation exposure limits set forth for an uncontrolled 
environment. End users must follow the specific operating instructions for satisfying RF 
exposure compliance. This equipment should be installed and operated with minimum 
distance 20cm between the radiator & your body. 

This transmitter must not be co-located or operating in conjunction with any other antenna 
or transmitter. 
 
 
Règlementd’ Industry Canada 
Les conditions de fonctionnement sont sujettes à deux conditions: 
 
(1) Ce périphérique ne doit pas causer d’interférence et. 
(2) Ce périphérique doit accepter toute interférence, y compris les interférences pouvant 
perturber le bon fonctionnement de ce périphérique. 
 
 

 
European Union Regulatory Notice 
 
Products bearing the CE marking comply with the following EU Directives: 
 
 Low Voltage Directive 2006/95/EC 
 EMC Directive 2004/108/EC 
 Restriction of the use of certain hazardous substances (RoHS) Directive 2011/65/EU 
 R&TTE Directive 1999/5/EC 
 
CE compliance of this product is valid if powered with the correct CE-marked AC adapter 
provided by I.R.I.S. s.a. 
 

This product satisfies the Class B limits of EN55022, EN55024, safety requirements of EN 
60950 and ROHS requirements of EN50581. 

 

*This machine is certified as Class 1 LED product. 
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Warning and Precautions of the lithium-ion battery 
 

Warning:  
Danger warning to prevent the possibility of the battery from leaking, heating, explosion, 
please observe the following precautions:   
 

 Don’t immerse the battery in water and seawater. Please put it in cool and dry 
environment if no using.  

 Do not discard or leave the battery near a heat source as fire or heater  

 Being charged, using the battery charger specifically for that purpose  

 Don’t reverse the positive and negative terminals  

 Don’t connect the battery to an electrical outlet directly.  

 Don’t connect the positive and negative terminal directly with metal objects such 
as wire. Short terminals of battery is strictly prohibited, it may damage battery.  

 Do not transport and store the battery together with metal objects such as 
necklaces, hairpins.  

 Do not strike, throw or trample the battery.  

 Do not directly solder the battery and pierce the battery with a nail or other sharp 
object.  

 Do not use lithium ion battery and others different lithium polymer battery model 
in mixture.  

 Prohibition of use of damaged cells.  

 Don’t bend or fold sealing edge. Don’t open or deform folding edge. Don’t fillet the 
end of the folding edge.  

 Don’t fall, hit, bend battery body.  

 Battery pack designing and packing Prohibition injury batteries.  

 Never disassemble the cells.   

 Keep the battery away from babies.  

 Any components contacting these two edges, they must be insulated.  
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Caution:  
 

 Risk of explosion if battery is replaced by an incorrect type. Dispose the battery 
according to local regulations. 

 Never place batteries or devices on or in heating devices, such as microwave 
ovens, stoves, or radiators. Batteries may explode when overheated or its 
performance will be degenerate and its service life will be decreased.  

 Do not use it in a location where is electrostatic and magnetic greatly, otherwise, 
the safety devices may be damaged, causing hidden trouble of safety.  

 If the battery leaks, and the electrolyte get into the eyes. Do not wipe eyes, 
instead, rinse the eyes with clean running water, and immediately seek medical 
attention. Otherwise, eyes injury can result.   

 If the battery gives off an odor, generates heat, becomes discolored or deformed, 
or in any way appear abnormal during use, recharging or storage, immediately 
remove it from the device or battery charge and stop using it.  

 Avoid charging batteries for more than a week, as overcharging may shorten 
battery life. Over time, unused batteries will discharge and must be recharged 
before use. 

 Disconnect chargers from power sources when not in use. 

 Use batteries only for their intended purposes. 

 Store the battery at 0°C to 40°C. 

 Avoid exposing your device and batteries to very cold or very hot temperatures. 
Extreme temperatures can cause the deformation of the device and reduce the 
charging capacity and life of your device and batteries. 

 Prevent batteries from contacting metal objects, as this can create a connection 
between the + and – terminals of your batteries and lead to temporary or 
permanent battery damage. 

 In case the battery terminals are dirty, clean the terminals with a dry cloth before 
use. Otherwise power failure or charge failure may occur due to the poor 
connection with the instrument.   

 Be aware discharged batteries may cause fire. Follow all local regulations when 
disposing of used batteries or devices. 

 Never crush or puncture the battery. Avoid exposing the battery to high external 
pressure, which can lead to an internal short circuit and overheating. 
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1. Overview 
 
 
 

1.1 Introduction 
 
Congratulations on your purchase of the mobile scanner. This scanner provides you 

flexibility to start easy scans (SD mode) by pressing the Scan button without connecting it 

to a computer or you may use it like a regular scanner to start advanced scans (PC mode) 

by installing the scanner driver and connecting to a computer.  

Before you install and operate the product, please take a few minutes to read through this 

manual. It provides proper instructions for you to install, operate and maintain the 

product. The following figure indicates the package contents. Please check all the items 

against your checklist. If you do not receive all the items, please contact your authorized 

local dealer immediately. 

1.2 Package Contents 

 

 
Scanner 

 

 

 
 

USB Power Adapter 

 
USB Cable 

 
Calibration Sheet 

 

 

Li-Ion Battery 

 

 

Software CD, including 
Quick User Guides 

 

Cleaning Cloth 

 

Note:  
1. Only use the USB adapter (DSC-5CU-05 050100 made by DVE) and the Li-ion Battery AP-

120 made by APACK/CB-PD(NP-120) made by City Bright included in the product. Using 
other power adapters may damage the machine and void the warranty. 
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2. Please unpack the packing carefully, and check the contents against the checklist. If any 
items are missing or damaged, please contact your dealer immediately. 

 
 
1.3 Front View 

 
 

 

Item Name Description 

1 
LCD display Displays the battery status and current scan settings. 

2 

 

 

 

System indicator 
light 

Indicates the operating/warning status of the scanner. 

Solidly lit in green: The power is turned on. 

Flashing in green: Scanning a document in 300 dpi. 

Flashing in orange: Scanning a document in 600 dpi. 

Flashing in red:  

 Paper is jammed. 

 A double feed has been detected and the scanner 
has stopped. 

 The feeder cover is open. 

 Another scanner error has occurred.  

3 

 

SD/PC 
 Wifi Switch 

 Press to switch to SD (Scan to SD) or PC (Scan to 
PC) mode.  

 In SD mode, hold down the button for one second 
to turn on the Wifi connection; Press again to turn 
off the Wifi connection. 

* Wifi connection is available for the SD mode only. 

4  Scan Press to start a scan. 

5 
JPEG/ 
PDF 

Press to switch to JPEG or PDF file format. 

6 
300/ 

600 dpi 
Press to switch to 300 dpi or 600 dpi. 

7 Color/ 
B&W 

Press to switch to Color or B&W mode. 

9             8    7      6  

1 
2 

3 
4 
5 
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Item Name Description 

8 Wifi Indicator 
Light 

Indicate the Wifi status. 

9 Feed tray 
This tray is used for feeding documents. Open it 
when scanning documents. 

 

 
 

 
 
 

Item Name Description 

1 
Document 

Extension Plate 
Open the plate to support the document when 
loading a long document. 

2 
Document Guides 

These guides ensure documents are fed straight. 
Raise the guides when loading a document, and 
then align them to the edges of the document to be 
scanned. 

3 Feeder Cover Open this when cleaning the scanner. 

 
 

 
 

1 

2 2 

3 
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1.4 Rear View 

 

 
 
 
 
 

Item Name Description 

1 
Plastic card 
feeder 

Used to insert and hold a business card or a 
plastic card. 

2 Memory card slot Used to insert a memory card. 

 

 

 

1.5 Side View 

  

 
 
 

Item Name Description 

1 Power switch 
Turn to the [ON] position to power on the 
scanner or turn to the [OFF] position to power 
off the scanner. 

2 Micro USB port 
Used to plug the micro end of the USB cable to 
connect to PC. 

 

 2 1 

1                     2 
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1.6 LCD Display 

 
 
 

 
 
 
 

 

Item Name Description 

1 Battery status Indicates the power status of the battery. 

2 
PC/Scan 
count/Error 

Indicates the PC mode, scan count or error.  

3 File format 
Indicates current file format for the scanned image. 
Choice: PDF, JPEG. 

4 Color mode 
Indicates current color mode. Choice: Color, Black 
and White. 

5 Memory card Indicates an inserted memory card. 

6 Resolution 
Indicates current resolution. Choice: 300 dpi, 600 
dpi. 

7 
Wifi 
connection 

Indicate the Wifi connection is turned on.  

 
 
 

4 
 
 

5 
 
 

6 
 
 

7 

1 
 
 

2 
 
 
3 
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2. Installation 
 

 
 
2.1 Precautions 

 Keep the product out of direct sunlight. Direct exposure to the sun or excessive 
heat may cause damage to the unit. 

 Do not install the product in a humid or dusty place. 

 Place the product securely on an even, flat surface. Tilted or uneven surfaces may 
cause mechanical or paper-feeding problems. 

 Retain the product box and packing materials for shipping purposes. 

 
 

2.2 Install the Battery 

 

Important! 
Note the scanner scans a document using the power from the battery in both the SD and PC 
mode. Be sure to install the battery and charge it when the battery power is getting low.  

 
 
1. Open the feed tray.  

 
 

2. Open the feeder cover. 
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3. Open the battery cover. 
 

 
 

 
 

 

 



User Guide 

 2-3 

 
 

4. Load the battery into the battery container. Make sure the battery is loaded with the 
correct polarity. Note the copper strips on the battery should be touching the copper 
strips on the device. Note: Please use only the supplied battery. 

 
 
5. Close the battery cover and feeder cover. 
 

2.3 Charge the Battery 

 
There are two methods to charge the batteries, 
 
1. Through the USB cable to the computer. 

2. Through the USB power adapter to the electric outlet.  
 

2.3.1 Via the USB Cable 

 

1. Turn off the scanner. 

2. Connect the micro USB connector to the USB port of the scanner. 

3. Connect the other USB connector to the USB port on your computer. 
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2.3.2 Via the USB Power Adapter  

 

1. Turn off the scanner. 

2. Connect the micro USB connector to the USB port of the scanner. 

3. Connect the other USB connector to the USB port of the USB Power Adapter. 

 

 
 

 

Important: 
 For first-time use, please charge the battery for at least 4 hours. 

 While charging the battery, the green LED light will be solidly on. After the charging 
is completed, the LED light will be extinguished. 

 When the battery is fully charged, an A4-sized of page can be scanned for 200 times 
at 300 dpi (or 150 times at 600 dpi)! 

USB Power 
Adapter 
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2.4 Install a SD Card 

 
To scan in SD (Scan to SD) mode, the scanner’s built-in storage disk has approximately 
128MB of space that can be used to store scanned images. You can install a SD card to the 
SD slot of the scanner to expand your storage. Gently press in until the SD card is latched. 
 
 

 
 
 

Note: 

The scanner only accepts SD card in FAT16 or FAT32 format. NTFS and other file formats are 
not supported. 
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2.5 Install the Feed Extension Plate 

 

1. Open the feed tray. 

 
 
2. Open the feed extension plate. 
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3. Raise the document guides and adjust them to the size of your documents. 
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2.6 Install the Software 

The IRIScan Pro 3 Wifi comes with the software packages Readiris Corporate 14 (PC and 
Mac), Cardiris Corporate 5 (PC), Cardiris Pro 4 (Mac) and IRISFile 12.5 
 
In Windows you can san directly from these applications, provided you install the Twain 
driver from the DVD-ROM.  
 

Note:  
To ensure your computer can identify the USB scanner, please install scanner driver first 
before connecting the scanner to your computer. 
 

On Mac OS you need to scan in Easy SD mode, and load the scanned images in Readiris and 
Cardiris. 
2.6.1 System Requirements 
 

Minimum System Requirements Windows PC 

Operating System Windows 8, Windows 7 and Windows Vista 

CPU Pentium IV or equivalent 

RAM 1 GB 

HD space 300 MB 

Hardware DVD-ROM drive, 1 free USB 2.0 port 

 
Minimum System Requirements Mac OS 

Operating System 
Mac OS Leopard, Snow Leopard, Lion and Mountain Lion (no driver 
installation required) 

CPU Intel processor 

RAM 1 GB 

HD space 300 MB 

Hardware DVD-ROM drive, 1 free USB 2.0 port 

 
Minimum System Requirements iOS and Android OS 

Operating System iOS 5.1 or later and Android OS 4.0 or later 
 

2.6.2 Installation on Windows 

1. Place the supplied DVD-ROM onto your DVD-ROM drive. 

2. The software setup menu appears. If not, run “setup.exe” from the DVD-ROM to make 
it appear. 
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Contents of the setup menu: 

 IRIScan Pro Wifi: install the driver to use the scanner in PC mode, and scan 
directly from Readiris and Cardiris. 

 Readiris Corporate 14: this is I.R.I.S.’ flagship OCR (Optical Character 
Recognition) software. 

 Cardiris Corporate 5: this is I.R.I.S.’ business card reading software. 

 IRISFile Pro 12.5: this is a file management application. 
 Quick User Guides: view the quick and detailed user guides of the scanner and 

its software. 

3. Click IRIScan Pro Wifi to install the scanner driver on your computer. 
4. Click Readiris Corporate 14 to install it. 
5. Click Cardiris Corporate 5 to install it. 
6. Click IRISFile Pro 12.5 to install it. 
 

2.6.3 Installation on Mac OS 

1. Place the supplied DVD-ROM onto your DVD-ROM drive. 
2. Click the DVD-ROM icon that appears on the Desktop. 
3. Click Readiris Corporate 14 to install Readiris on your computer. 

You will be asked to enter a serial number. The serial number contains 15 digits and can be 
found inside the product box. 

4. Click Cardiris Pro 4 to install Cardiris on your computer. 
 
2.6.4 Power On the Scanner 

Move the power switch on the left side of the scanner to the “ON” position to turn on the 
scanner. 
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2.6.5 Connect to a Computer 

 

1. Connect the micro USB port of the USB cable to the USB port of your scanner. 

2. Connect the other end to the USB port of your computer. 

 
 

3.  The computer should detect a “Mass Storage Device”.  
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2.7 Suitable and Unsuitable Original Types 

 
Suitable Original Types 

The scanner used with the feeder dock is designed to obtain the best scanning results with 
the following types of originals: 
 
 Photos and documents (3”x5”, 4”x6”, 5”x7”, 8.5”x14”) (76 x 127mm, 102 x 152 mm, 

127 x 177 mm, 216 x 356 mm) 

 Business cards [standard 3.5” x 2” (88 x 50 mm) or larger] 

 Document weight: 60 ~ 107 g/m² (16 to 28 lb) 
 Long Page (216 x 916 mm) (available for 300 DPI only) 
 
 
Unsuitable Original Types 

Do not use the following types of originals for scanning in the feeder dock, otherwise the 
feeder dock may malfunction or cause the original to jam in the slot. 
 

 Originals thicker than 1.00 mm 

 Original with either side shorter than 50 mm 

 Originals with lots of black or dark colors 

 Original with dark colors surrounding the edges 

 Printed media (newspapers, magazines, etc 

 Soft and thin materials (thin paper, cloth, etc.) 

 Curl or wrinkle originals 

 Originals with staples or paper clips. 

 Originals that exceed acceptable size – 8.5” (width) x 14”(length) (216 x 356 mm) 
(in 600 dpi) (SD Mode) 

 

 

2.8 Load a Document 

 

Fanning Your Document 

Standard paper size should feed easily through the scanner. To avoid occasional paper 
jam when automatically feeding multiple documents, loosen the paper before loading. 
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Document Feeding 
 

1. Load the stack of document FACE DOWN with the top of the pages pointing into the 
feeder. Up to 8 pages of plain paper can be loaded at one time in the feeder. 

2. Make sure the document guides are aligned with the edges of the stack. 
 

 
 

 

 

 

  
24B  
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3. Operation in Easy (SD) Mode 
 

 
 

3.1 Power on the Scanner 

Turn the Power Switch to the [ON] position to turn on the scanner. The LED indicator 

light will be lit and the default scan settings will be displayed on the LCD screen. 

 
 

 
3.2 Switch to the SD Mode 

 
To start easy scan (SD mode) to save your images to the system’s built-in memory or your 
SD card, make sure your scanner is in the following SD (Scan to SD) mode. The SD mode is 
also a default mode when the scanner is turned on:  
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3.3 Choose Your Desired Scan Settings 

 

 

 

After the scanner is turned on, the LCD displays the default scan settings, Resolution: 300 
dpi, Color mode: color, File format: JPG. 
 

Color Mode 

(Color/BW) 

The scanner offers two color modes for your scanned image, Color 
(default, fits for photos) and Black and White (fits for text 
document). 

Press [Color/BW] to switch to BW mode. 

Save Format 

(JPEG/PDF)  

The scanner offers two types of file formats for your scanned image, 
JPEG (default, fits for photos) and PDF (fits for text document). 

Press [JPEG/PDF] to switch to PDF file. 

Resolution  

(300/600) 

The scan resolution is measured in dpi (dots per inch). The higher 
the resolution, the more details the scanned image will be displayed. 
However, a higher resolution may require more disk space stored in 
the SD card. The scanner offers two types of resolution, 300 dpi 
(default, fits for most document) and 600 dpi (higher resolution). 

Press [300/600 dpi] to switch to 600 dpi. 
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3.4 Start a Scan 

 
Press the [Scan] button to start a scan and the paper will feed through the scanner. 

 

 



 

 3-4 

 
 

3.5 Scan a Card 

 
1. Make sure the feeder cover and paper tray are closed as shown. 
 

 
 
 
2. Insert your plastic card FACE DOWN from the back of the scanner and align it 

according to the card feeder as shown.  

 
 

 
 

3. As long as the card is inserted in the feeder, the scan will be started automatically.  
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3.6 Scan Dark Pictures 

 

The scanner has a built-in cropping function that automatically detects and crops dark edges 
and dark areas against the cropping baseline background during the scan process. To 
prevent poor cropping, align the original straight against paper guides and ensure there is 
adequate space in front of the feeder for the originals to completely feed through. Scanning 
on a flat and uncluttered surface is recommended. 
 
The following example illustrates a 4”x6” original photo scanned with auto-crop: 

 

Original/Auto-crop on (default) 

 

If the original is fed slightly crooked, the original is only cropped a pre-defined maximum 
amount, as shown in the following illustration: 

 
 Max. 1.5mm 

Max. 1.5mm 
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3.7 Power off the Scanner 

 

When your scanning job is completed, move the Power switch to the [OFF] position to turn 
off the scanner. The LCD display will be off. 
 
 When the scanner is left idle for 3 minutes, the default Power Save mode automatically 

powers off the scanner. 

 
 

 

 

3.8 View or Download the Scanned Images 

Connect the scanner to your computer to access the scanned images from the scanner’s 
built-in disk or from the inserted memory card without using an independent card reader. 
While connected, you can view your scanned image files, copy and paste files from one 
storage area to the other, or delete files you don’t wish to keep. 
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3.8.1 Connect With Windows XP or Later 

 

1. Turn on the scanner. 

2. Insert the memory card containing your scanned images into the scanner’s memory 
card slot. Skip this step if images are stored on the built-in disk. 

3. Connect the included USB cable to the scanner and to your computer. 

4. Your computer should recognize the card or the scanner as a Removable Disk (IRIScan 
Pro Wifi). 

5. Click the Removable Disk and you will find a folder of “DCIM” is created and all the PDF 
files will be stored in the subfolder of “200DOC” and the JPEG files in the subfolder of 
“100PHOTO”. File name starts from IMG_0001.pdf or IMG_0001.jpg. 

 

3.8.2 Connect With Macintosh Computer 

 

When the computer recognizes the scanner built-in disk or inserted memory card, the 
volume icon appears on the desktop. 
 
To view the contents of the built-in disk or memory card, double-click the icon to open a 
Finders window. 
 

3.8.3 Access Your Scanned Images 

 

Each scanned image is given a file name with the prefix IMG_ followed by a 4-digit 
sequential number in the order the images are stored. For example, IMG_0001.jpg, 
IMG_0002.jpg, IMG_0001.pdf, IMG_0002.pdf, etc.  
 
JPG files are stored in a sub folder titled DCIM\100PHOTO. The folder stores 9999 photo 
files, and then automatically creates another sub folder titled 101PHOTO, and so on to 
199PHOTO. 

 

PDF files are stored in a sub folder titled DCIM\200DOC. The folder stores 9999 document 
files, and then automatically creates another sub folder titled 201DOC, and so on to 
299DOC. 

3.8.4 Load Scanned Images in Readiris and Cardiris 

 

When using the scanner in Easy SD mode you can load your scanned images from the 
memory card or built-in disk directly in Readiris and Cardiris. 

Note that in Windows you can also use Readiris and Cardiris to scan documents directly in 
Advanced PC mode. See the sections 4.2 and 4.3 for more information. 

 
Readiris Corporate 14 (Windows) 

1. Start Readiris. 
When you start Readiris for the first time you are asked to activate it. Click Yes and 
enter the Activation code you find on the label inside the DVD box. Then click OK. 
Note that an internet connection is required to do the activation. 
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2. Connect your IRIScan scanner to your computer and power on the scanner. 

3. Readiris opens the scanner memory folder. Select the documents to load, then click 
Open. 

 

4. The files can now be processed. To learn how to do so, see the Readiris User Guide on 
www.irislink.com/support. 

Tip: to load images at a later time, click the From File button on the main toolbar. 

 

Cardiris Corporate 5 (Windows) 

1. To start Cardiris for the first time, right-click the Cardiris shortcut on the Desktop 
and click Run as Administrator. 

2. In Cardiris select the country of your scanned business cards. 

 

3. Connect your IRIScan scanner to your computer and power on the scanner. 

4. Cardiris detects if card images were scanned to the scanner memory. Click Yes to 
select them. Cardiris then opens the right folder. 

5. The files can now be processed. To learn how to do see, see the Cardiris User Guide 
on www.irislink.com/support. 

www.irislink.com/support
file:///C:/Documentation/IRIScan%20Pro%203%20WiFi/User%20Guides/www.irislink.com/support
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Tip: to load other images at a later time, click the down arrow next to Scan, and select 
Load. Now click the Load button to load images. 

 

Readiris Corporate 14 (Mac OS) 

1. Start Readiris. 
When you start Readiris for the first time you are asked to activate it. Unactivated 
versions can only be used for 30 days. 

2. Click Skip for now. See the Readiris User Guide on the DVD to learn how to activate 
it. 

3. Connect your IRIScan scanner to your computer and power on the scanner. 

4. Readiris opens the scanner memory folder. Select the documents to load, then click 
Open. 

5. The files can now be processed. To learn how to do see, see the Readiris User Guide 
on the DVD-ROM. 

Tip: to load images at a later time, click the File button on the main toolbar. 

 

 

Cardiris Pro 4 (Mac OS) 

1. Start Cardiris. 

2. Click the globe icon and select the required country from the list. 

3. Connect your IRIScan scanner to your computer and power on the scanner. 

4. Cardiris opens the scanner memory folder. Select the business card to load, then click 
Open. 

5. The documents are recognized automatically. The information on the cards is 
assigned to the corresponding data fields. 

6. The files can now be processed further. To learn how to do see, see the Cardiris User 
Guide on the DVD-ROM. 

Tip: to load other images at a later time, click Load and Create and browse for the 
images to open. 

3.8.5 Disconnect the Scanner 

 

CAUTION: Do not remove the memory card or disconnect the USB cable while the computer 
is accessing stored files. 

 
 
Disconnect the Scanner from a Windows PC 
 
1. On the Windows System Tray, click the hardware removal icon as indicated below. 

2. Click Safely remove USB mass Storage device – Drive (<Drive Letter:>) 
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3. When the Safe to Remove Hardware message appears, you can safely remove the 
scanner’s USB cable. 

 
 
Disconnect the Scanner from a Macintosh 
 

1. Click and drag the volume icon on the desktop to Trash. 

Or 

Click the eject button next to the volume name in the Finder’s window. 

 

2. Disconnect the scanner from your computer. 
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4. Operation in Advanced (PC) Mode – 
Windows only 

 

 

 

Attention: in order to use the scanner in Advanced (PC) mode, you must have installed the 
scanner driver. 

In Advanced (PC) Mode you can scan directly from your software applications, such as 
Readiris and Cardiris, and enhance the image quality thanks to the scanner’s Twain interface. 

Note that the Advanced (PC) mode is only availabe for Windows. 

 

4.1 Switch to the PC Mode 

To start advanced scan (the PC mode) to save your images to your computer, you need to 
switch the scanner to the PC mode by pressing the “SD/PC Wifi” button until PC is displayed 
in the LCD-display as shown. 
 

 
 

4.2 Scan Documents with Readiris Corporate 14 

1. Start Readiris. 
When you start Readiris for the first time you are asked to activate it. Click Yes and 
enter the Activation code you find on the label inside the DVD box. Then click OK. 
Note that an internet connection is required to do the activation. 

2. Click the down arrow below Scan, and click Settings. 

 
3. Click Configure to select the Twain source. 

 
4. Select the IRIScan Pro Wifi 6.0 from the list, and click Select. 

If the IRIScan is not listed here, it means the driver has not been installed correctly. 
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5. Click Scanner Model. 
6. Select IRIScan Pro 3 Wifi. You can now configure the scanner settings in the Readiris 

dialog box. 
7. Or select IRIScan Pro 3 Wifi (User Interface). In that case the Scanner Properties 

dialog box opens before scanning. In that window you can configure advanced scanner 
settings. Also see the section 4.4 A Glance at the Scanner Properties Dialog box for 
more information. 

8. Click Ok to close the scanner settings. 
9. Then click Scan to scan your documents. 

For more information on how to scan and process documents in Readiris, see the User 
Guide on www.irislink.com. 

 
4.3 Scan Documents with Cardiris Corporate 5 

1. To start Cardiris for the first time, right-click the Cardiris shortcut on the Desktop and 
click Run as Administrator. 

2. In the main toolbar click Settings > Scanner. 
3. Select IRIScan Pro Wifi and click Next. 

 
4. Then click Scan to scan your documents. 

For more information on how to scan and process documents in Cardiris, see the User 
Guide on www.irislink.com. 

 

4.4 Scan Documents with the Capture Tool 

The Capture Tool is installed by default when you install the scanner driver. With this tool, 
you can perform simple scans and view the captured images. In addition, it helps you 
complete your scan at a rated speed. 
 

www.irislink.com
file:///C:/Documentation/IRIScan%20Pro%203%20WiFi/User%20Guides/www.irislink.com
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The following procedure describes how to start a simple scan. If there is an error, please 
review the preceding section to check if the cable connection and scanner driver have been 
successfully installed. 
 
Before you begin, be sure the scanner is on. 
 
1. Select Start>Programs>IRIS IRIScan Pro Wifi Scanner>Capture Tool. 

The Select Scanner Model dialog box will be displayed.  
 

2. Select your driver type and scanner model and click OK. The following Capture Tool 
dialog box will be displayed. 

 
 
 

 
 
 

 

3. Choose your desired file format from the File Format drop down list box. (Default is BMP, 
other choice includes TIFF, GIF, and JPEG.) 

4. Type your desired folder name and file name in the File Path box. (Default is C:\My 
Scan\Image.) 

Note: If you do not wish to save the scanned image, deselect the Save button since 
default is Save Enable. In this case, the thumbnail view will be disabled. And therefore, 
after viewing all the scanned images, only the last one will remain on the screen.  

 

5. Click the Setup button ( ) or choose Setup from the File menu to prompt the 
Scanner Properties dialog box. 

 

 
 

 
6. From the Image Selection Box, choose your desired image type for your scanned image. 

(Default is Front B&W) If you have a duplex scanner, choose Front and Rear to scan both 

Image 
Selection 

Box 

Setup    

Actual Size Fit Page 

Scan Save   File Format  File Path 
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sides of your document. 

7. Click OK to quit the Scanner Properties dialog box. (To learn more details about the 
Scanner Properties dialog box, please see the subsequent chapter, Using the Scanner 
Properties Dialog Box.) 

8. Place your document face down on the document glass or face up in the auto document 
feeder. 

9. In the Scan Validation dialog box, click the Scan button ( ) or choose Scan from 
the File menu. 

10. The document will be scanned and displayed in the Scan Validation screen. After the 
scanned images have been displayed, your scanner installation verification is completed.  

 

 
 
 

11. You can view the scanned image in Fit Page ( ) or Actual Size (100%) button ( ) 
from the Viewing toolbars at the right side. 

12. Click the Close box or Quit from the File menu to exit the Scan Validation Tool. 
 

4.5 A Glance of the Scanner Properties Dialog Box  

Fit Page View 

Thumbnail View 
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1. Tab Options Choice: Image, Compression, Color Dropout, Paper, Preview, 
Options, Settings, Information. 

2. Image Selection 
Box   

Choose your image type and the side of document you wish to 
scan. Options vary based on type of scanner.  

3. Brightness Adjust the brightness level from –100 to +100.  

4. Contrast Adjust the contrast level from –100 to +100. 

5. Resolution Determine the quality of the scanned image. The industry 
standard is 200 dpi. 

6. Invert Reverse the color of your scanned image. 

7. Scan Source  Choice: Auto Document Feeder.  

8. Defaults Reset all values on the tabs to the factory default settings. 

 
 
 
 
 

 

3 
4 

5 

6 
 
7 

1 

 

2 
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5. Access the scanned images 
through Wifi (SD Mode) 

 
 
Using the scanner’s Wifi connection (available only for the SD mode, you can wirelessly 
connect to your private cloud to browse or download your scanned image files from the 
scanner to your computer, Android or iOS devices.  
 

Note:  
 The Scanner Wifi access point is for browsing, downloading, or deleting scanner files 

only. It cannot be used for Internet browsing. 

 The scanner does not allow you to scan and connect to Wifi at the same time. If you 
press the [Scan] button to start a scan in the Wifi mode, the Wifi mode will be off 
temporarily. When the scan is finished, the scanner automatically connects to Wifi again.  

 

5.1 Access the Scanned Image through Wifi 

1. Turn Wifi mode on by pressing the SD/PC Wifi button for one second in SD mode until 
the Wifi icon is shown in the LCD-display. 

 
 
2. Wait approximately 40 seconds while the data is indexed, the Wifi blue LED flashes. 

When the blue LED turned solidly on, this indicates that Wifi status is ready. 
 

 
 
3. To connect your computer, iPhone, iPad or Android device to the scanner, use the 

device’s Wifi settings to select the scanner’s network ID “I.R.I.S. -XXXX” [last four digits 
of Access Point’s MAC address]”. 

 
 PC users: Go to the Wifi Network icon and select the network ID (I.R.I.S. -XXXX). 

No password is required; wait for the connected status confirmation. 

 Mac users: Click the Wifi network icon on the menu bar and select the network ID 
(I.R.I.S. -XXXX). No password is required; wait for the connected status confirmation. 
Make sure you are connected to only one IP interface (either Wifi or Ethernet port). 
The Client IP would be 10.10.100.x range. 
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 iPhone & iPad users: Go to Settings→Wifi→ select the network ID (I.R.I.S. -

XXXX). No password is required; wait for the check mark to confirm the connected 
status. 

 Android users: Go to Settings→Wifi Settings→ select the network ID (I.R.I.S. -

XXXX), and then tap Connect. No password is required; wait for the connected 
status confirmation. 

 
4. Open an Internet Explorer window, the I.R.I.S. PhotoView page will be displayed. 
 

 PC users: Click Start→Program Files→Internet Explorer to open an Internet 

browser. 
 
 Mac, iPhone & iPad users: Click or tap the Safari icon to launch a browser session. 
 
 Android users: Device setups varied, but generally you can tap on an Internet 

browser icon on your Home screen, or tap on the message “Login may be required”. 
 

If you are not directed to the IRIScan Pro page utomatically, you must type in 
your default home page URL, e.g.,http://www.google.com or type in 
http://10.10.100.1. This step will redirect you to “I.R.I.S. PhotoView” page. 

 
5. The login screen is briefly displayed, and then the image files found in the built-in storage 

or on a SD card are automatically displayed. 
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6. Click or tap on any image to view in full screen. 

 
 

5.2 Use Options under Image Thumbnails 

 
 
Click the Setup button to prompt the Setup page. Through the Setup page, you can change 
the scanner’s network ID or create a user name and password to protect your data. 
 
 

  
 
 The display defaults to JPG mode, displaying all JPG files. To view JPG images full screen, 

click or tap on an image; a slideshow automatically begins to display all images. 
 
 To access PDF files, click or tap the PDF Mode button. All PDF files are displayed, but 

you must download PDF files before they can be opened. 
 
 To switch back to JPG mode, click or tap the JPG Mode button. 
 
 

 
 
You can easily download the images from the scanner to your computer or device. 
 
1. Click or tap in the select box next to the file name(s) that you want to download. 

2. Click or tap Download. 

Computers: You are prompted to Open or Save the files. If saving, you are also 
prompted for the location on your computer to save the files. 

Tablets & Phones: The files are automatically downloaded to your Photo Gallery into a 
folder titled Download. 
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iPhone/iPad Devices: 
 
1. Open Safari Browser, the I.R.I.S. PhotoView page will be displayed. 

2. Select the photo(s) to open. 

3. A new browser will appear with selected photo. 

4. Press on slideshow image for 1-2 seconds, select “Save Image” 

5. The photo or document will now appear in your photos. 

 
Please note only 1 photo or JPG image can be downloaded at a time with multiple selected. 
Additional PDF viewer application is required for download and view PDF files on iOS system. 
 
 
Android Devices: 
 
1. Open a Browser, the I.R.I.S. PhotoView page will be displayed. 

2. Select the photo(s) or document(s). 

3. Select the download icon. 

4. Document(s) or image(s) selected will begin downloading. 

5. Document(s) or image(s) can be found in your gallery. 

 
Please note multiple images or documents can be downloaded at a time. 
Note: The file path of the downloaded photos or document may vary depending on the 
manufacturer of the tablet and phones. E.g., some in SD Card/download and some ininternal 
memory User/download/.  
 
 

 
 
 You can quickly delete image files from the scanner. 
 
1. Click or tap in the select box next to the file name(s) that you want to delete. 
2. Click or tap Delete . 

3. The file(s) are automatically deleted (you won’t be prompted to confirm the deletion). 
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5.3 Reset Login Settings 

Should you forget your login user name and password, you can press the Reset button for 10 
seconds to resume to factory settings without login name and password. Press the Reset 
button with a pin, paperclip or pointy object. The Reset button is recessed, so you will have 
to insert the object inside the hole to press the button. 

 
 

 

5.4 Exit the Wifi Mode 

To exit Wifi mode, simply press the SD/PC Wifi button again. The Wifi icon in the LCD-
Display will be off.  

 
 
 
Attention: when Wifi mode is on, the scanner does not time-out and automatically turns off 
like it does normally. Therefore, it is recommended that you connect the scanner to your 
computer or power adapter, via the micro USB cable, whenever you have Wifi mode on. 
 

IMPORTANT: Be sure to re-connect your computer, tablet or phone to your normal Wifi 
network when you are finished with your scanner connection so you will be able to connect to 
Internet, your email and other web related locations/programs again. 
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6. Enhance Your Images with the 
Scanner Properties Dialog Box (PC 
Mode) 

 

 

 

 

By switching to the “PC” mode, installing the scanner driver and connecting the scanner to a 
computer, you can scan via the TWAIN user interface (Scanner Properties dialog box) from 
your TWAIN-compliant image-editing software application and enhance your image quality 
with various features. 
 
The Scanner Properties dialog box allows you to configure the scanner’s settings. It consists 
of several tabbed windows each of which will be described in this chapter. 
 

Note: 
In this chapter, all options are available based on a duplex (double-side) scanner. If you 
have purchased a simplex (single-side) scanner, all options are available for single sided 
only. 

 

  
The Scanner Properties dialog box 
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6.1 Buttons on the Scanner Properties Dialog Box  

 
 

The buttons on the Scanner Properties dialog box 
 
 

Note: 
The command buttons in the bottom of the Scanner Properties dialog box vary due to 
different software applications. Some applications such as Capture Tool may show “OK” and 
“Cancel” while others may show “Scan” and “Close”. In this document, the Scanner 
Properties dialog box will be shown using Capture Tool. 

 

 
Buttons Description 

Defaults Click the Defaults button, the factory default settings will be shown 
on each tab.  

Scan/OK Scan: After all the scan settings are satisfactory, click the Scan 
button to start scanning your document. 

OK: If all scan settings are satisfactory, click the OK button to save 
the settings and leave the Scanner Properties dialog box. 

Close/Cancel Click the Close or Cancel button to leave the Scanner Properties 
dialog box. 
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The following table shows the default settings： 

 

Tab name Default settings 

Image Image：Front B&W 

Binarization：Dynamic Threshold 

Resolution：200 dpi 

Invert：Blank on White 

Scan Source：Auto Document Feeder 

Threshold：None 

Brightness：None 

Contrast：None 

Compression None 

Color Dropout None 

Paper Cropping：Automatic 

Deskew：Yes 

Orientation：Portrait 

OverScan：0.00  

Unit：Inch 

Preview None 

Options Image Control Option：None 

Setting Show Scanning Progress：Yes 

Show Warning Message：Yes 
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6.2 The Image Tab  

The Image tab allows you to choose the front side and (or) the rear side of your document, 
the type of image, and to set several basic scan settings. 
 

 
 

The Image tab dialog box 
 

6.2.1 The Image Selection Box 

Image Type Description 

Color Choose Color if you wish to scan a color image for your original in 
color.  

Gray Choose Gray image if your original contains actual shades of gray. 

B&W Choose B&W if your original contains only text, pencil or ink sketch. 

  
 

B&W Gray Color 
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6.2.2 Other Image Options 

 

Binarization This is the process of converting a grayscale or color image to a bi-tonal 
image. There are several different methods of performing this conversion. 
Options: Fixed Processing. 

 

 Fixed Processing: Used for black-and-white and other high contrast 
documents. A single level is set to determine the black-and-white 
transition. The threshold is programmable over the entire density range. 
Fixed Processing sets Contrast to 0. If Fixed Processing is selected, 
Contrast is not available. 

 

 

Threshold Used to convert a grayscale image to a  
bi-tonal image. The value ranges from 0 to 255. A low threshold value 
produces a lighter image, and can be used to subdue backgrounds and 
subtle, unneeded information. A high threshold value produces a darker 
image, and can be used to help pick up faint images.  
Adjust the threshold setting by dragging the Threshold sliding bar to the left 
or right to achieve the desired threshold setting. 

 

 

 

200 dpi, Threshold:50, 
Brightness: 0 

 

 

200 dpi, Threshold:100, 

Brightness: 0 
 

 
Gray  
Document Type: Normal  
Three options of document type are provided when you choose Gray as the image type for 
your scanned document. Choice: Normal.  
 Normal: When using Normal, Threshold, Brightness, and Contrast can be adjusted.  
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Brightness Adjusts the lightness or darkness of an image. The higher the value, 
the brighter the image. Drag the slider to the right or left to increase 
or decrease the brightness. The range is from –100 to +100. 

Contrast Adjusts the range between the darkest and the lightest shades in the 
image. The higher the contrast, the bigger the different grayscale. 
Drag the slider to the right or left to increase or decrease the 
contrast. The range is from –100 to +100. 

 

  
 

Brightness: -50 Brightness: 0 
(Normal) 

Brightness: +50 

   

Contrast: -50 Contrast: 0 
(Normal) 

Contrast: +50 
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Resolution A good control of the resolution results a good detail of an image that 

scans. The resolution is measured by dots per inch (dpi). Normally, 

the greater the dpi number, the higher the resolution and the image 

file size. Be aware that greater resolution takes more time to scan, 

and more disk space for the scanning image. For your information, an 

A4 size color image scanned at 300 dpi at True Color mode consumes 

approximately 25 MB of disk space. A higher resolution (usually 

means over 600 dpi) is only recommended when you need to scan a 

small area at True Color mode.  

Choose a resolution value from the drop down list. The default value is 
200 dpi. Available resolutions are 75, 100, 150, 200,300, 400 and 
600. Or you may choose your desired value by clicking the box in the 
right side of the drop down list and press the arrow key to select your 
desired value and then click the Add button to include it in the drop 
down list. Note: The resolution is up to 300 dpi if an imprinter or a 
MICR reader is installed or connected to the scanner. 

 

Resolution: 75 dpi 

 

Resolution: 150 dpi 

 
 
Invert Reverses the brightness and the colors in the image. The default setting is 

Black on a White background. Reverse mode is White on a Black background. 
For color images, each pixel will be changed into its complementary color at 
the command of Invert. 

 

 

Black on White 

 

 

White on Black 
 

Scan 
Source 

Choice: 

Auto Document Feeder: Used to scan multiple pages. 
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6.2.3 Scanning Color Images 

The following options are available for scanning color images.  

 Brightness 
 Contrast 
 Resolution 
 Invert 

 

6.2.4 Scanning Grayscale Images  

The following options are available for scanning gray images.  

 Brightness 
 Contrast 
 Resolution 
 Invert 

  

6.2.5 Scanning B&W Images  

The following options are available for scanning B&W images.  

 Binarization (Dynamic Threshold) 
 Resolution 
 Invert 

 
Or 

 Binarization (Fix Processing) 
 Threshold 
 Brightness 
 Resolution 
 Invert 
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6.2.6 Editing Profiles 

 
The Scanner Properties dialog box allows you to change and save your frequently used scan 
settings into a profile. You can edit these profiles by renaming or deleting them.  
 
To add a new profile, 
 
1. Customize your settings. (For example, change your resolution, image type, cropping 

method, scan size, or other scan settings.)  
2. Click the Image tab and then choose “Profiles” to prompt the “Edit Your Profile” dialog 

box.  

 
 
3. Click “Add” to enter the name of the profile and then choose “Save”. 

 
 
4. The new profile will be saved and shown in the “Profiles” dropdown list box.  
 
 
To load a profile,  
 
1. From the Image tab dialog box, choose your favorable profile from the “Profiles” 

dropdown list box. 

 

2. Your favorable profile will be immediately loaded and displayed on Scanner Properties 
dialog box. 
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To delete a profile, 
 
1. From the Image tab dialog box, click “Profiles” to prompt the Edit Your Profile dialog box. 

 
 
2. Choose the profile you want to delete from the dropdown list box. 
3. Click “Delete”. A Confirm message “Are you sure you want to delete this profile?” is 

prompted. 
4. Choose “Yes” to delete or “Cancel” to quit. 
 
 
To rename a profile, 
 
1. From the Image tab dialog box, click “Profiles” to prompt the Edit Your Profile dialog box. 

 
 
2. Choose the profile you want to rename from the dropdown list box and then click the 

Rename button. 
 
3. Enter new name for the profile. 

 
 
4. Choose “Save” to save the new profile or “Cancel” to quit. 
 

Note: 
The preset default profiles include Flatbed, Simplex-B&W, 200 dpi, Simplex-Gray, 200 dpi, 
Simplex-Color, 200 dpi, Duplex-B&W, 200 dpi, Duplex-Gray, 200 dpi, Duplex-Color, 200 dpi. 
If you have a simplex or a sheetfed scanner, the duplex or the flatbed option will not be 
available. 
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6.3 The Compression Tab 

The Compression tab allows you to compress your scanned image and choose the level of 

compression. Bi-tonal images are normally compressed using CCITT standard called Group 4 

(G4). Color and grayscale images are often compressed using JPEG technology. Move the 

JPEG Quality slider to the right or left to increase or decrease the level of compression. Note 

the greater the compression level, the lower image quality. Default is 50%. 

 

Note that the compression depends on your image editing application. If your image editing 

application does not support the type of compression format, then either a warning message 

will appear or the image quality of the compressed file will not be acceptable.  
 
JPEG (Joint Photographic Editor Group): This group developed and lent their name to a file 
compression standard for color and grayscale images that is widely used by scanners, and 
software applications. On Microsoft Windows-based systems, a file with the extension .jpg 
has normally been compressed using this standard. 

 
For scanning color or gray images, the following compressions are available: 

 None 
 JPEG 

 
For scanning B&W images, the following compressions are available: 

 None  
 G4 

 
 

 

The Compression tab dialog box 
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6.4 The Color Dropout Tab  

6.4.1 Color Dropout Selection 

Color Dropout tab allows you to drop either of the red, blue, or green color in your scanned 
image. If your image contains red color watermark or background, choose the R (Red) 
channel then any red watermark or background will be removed. This feature is used to 
sharpen your text when using OCR (Optical Character Recognition) software.  

Note that this function supports only black & white and gray images. Therefore, be sure to 

choose any black & white or gray image type while applying this function. 
 

 
 

The Color Dropout dialog box 
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6.5 The Paper Tab  

The Paper tab allows you to define values relating to image output (i.e., Auto Crop or not, 
Scan Area, OverScan).  
 

 

The Paper tab dialog box 

6.5.1 Cropping  

Cropping allows you to capture a portion of the document being scanned. Choice: 

Automatic, Fixed to Transport, EOP (End of Page) Detection, Relative to 

Documents. 

 

Options Description 

Automatic Automatic adjusts the cropping window according to different 
document sizes. Use this option for batches of mixed-sized 
documents. 

Fixed to 
Transport 

This feature allows you to define the area or zone to be imaged. 
Use for batches of same-sized documents. If you select this option, 
you can use the arrow keys to define the x and y offset values, 
width and length to redefine your scanned area. The Display 
window will show image placement as you change the values. 

EOP (End of 
Page) 
Detection 

This feature allows you to define the area or zone to be imaged. 
Use for batches of same-width but different length documents. If 
you select this option, you can use the arrow keys to define the x 
and y offset values, width and length to redefine your scanned 
area. The Display window will show image placement as you 
change the values. 
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Relative to 
Document 

This option allows you to crop different areas on your documents and 
deliver these images in B&W, Gray, or Color separately. For example, 
there are applications which require you to store the entire document 
in B&W and a part of the document in color to save storage space. This 
is useful for documents where a photograph or signature appears in a 
consistent area on the document such as resumes, and so on. 

 

The following options are only available when Fixed to Transport is selected.  

 X-Offset — the distance from the left end of the scanner to the left edge of the 
scanning area.  

 Y-Offset — the position from the top end of the document to the top end of the 
scanning area.  

 Width — the width of the scanning area.  

 Length — the length of the scanning area.  

 — relocate the scan area by click the arrow key on the cross sign while retain the 
scan size. View the result from the Display window.  

 
Relative to Document: (used for batches of same-sized documents) 

This option allows you to crop different areas on your documents and deliver these images in 
B&W, Gray, or Color separately. For example, there are applications which require you to 
store the entire document in B&W and a part of the document in color to save storage space. 
This is useful for documents where a photograph or signature appears in a consistent area on 
the document such as resumes, and so on.  

 
The following procedure describes how to reproduce the entire document in B&W and a 
portion of document (picture) in color.  

 
1. On the Paper tab, choose “Relative to Document” or “Fixed to Transport” from the 

Cropping option. 

2. Choose your scan size from the Scan Area option. The selected scan size will be 
displayed in a red rectangular box. This is also the scan size of your entire document. 
(For example, ISO B5. If you have not chosen a scan area and leave the selection as 
None, then the default area will be the scanner’s maximum.)  

 

 

1 
 
2 A red 

rectangular 
box 
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3. Click the Preview tab to display the Preview window. A black rectangular box appears to 

indicate the max. scan size your have just selected. 

 
 
4. Click the Preview button to view the entire image in low resolution to correctly crop your 

relative scan area.  

 

5. Select image type from the Image Selection box. The selected image will appear in 
highlighted color. (For example, Front Color) 

6. Place your cursor on the Preview window and click your left mouse button. A cross sign 
will appear as illustrated. Create your relative scan size diagonally by dragging the left 
mouse button to your preferable size. The selected area will appear in a red box as 
illustrated.  

 
 
 
 
 
 
 
 
 
 
 
 
 

7. Check the B&W image from the Image Selection box to scan the entire document. 

8. Click the Scan button to start scanning the document in two image types and sizes. (See 
the result in below.)  

 
 
 

A black 
rectangular 
box 

The Preview 
Image 

 

 

The Relative 
Area  

A Cross 
Sign 

The Preview 
Button 

The Image 
Selection 

Box 
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The entire document in B&W     The relative area in color 
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6.5.2 Other Paper Selection 

 
Scan Area  

Choose your desired paper size with the drop-down list box. Or you may select a custom 
paper size by clicking the Scan Area box and then click Add to include in the choice. 

Choice: None, US Letter- 8.5”x 11”, US Legal – 8.5” x 14”, ISO A4 – 21 x 29.7 cm, ISO A5 – 

14.8 x 21 cm, ISO A6 – 10.5 x 14.8cm, ISO A7 – 7.4 x 10/5 cm, ISO B5 – 17.6 x 25 cm, ISO 

B6 – 12.5 x 17.6 cm, ISO B7 – 8.8 x 12.5 cm, JIS B5 – 18.2 x 25.7 cm, JIS B6 – 12.8 x 18.2 

cm, JIS B7 – 9.1 x 12.8 cm, Scanner Maximum, Long Page (<36”). 

 
Long Page:  
When you need to scan documents whose length exceeds scanner maximum, please choose 
Long Page (<36”).  

OverScan 
Overscan allows you to add a specific margin at top and bottom or right and left (Options 
vary based on the type of scanner) of the edge of the image. This is used to reduce possible 
corner clipping on the skewed images and often applied to a batch of skewed document to be 
scanned in the auto document feeder. Select a value between 0 and +5 mm.  Note the 
overscan result will not be shown in the Display window and that the availability of the 
function varies based on type of scanner.  
 
Transport Timeout 
Set the amount of time the scanner will wait and then start auto scan after the first scan job 
is completed. If you have many separate documents need to be scanned at the same scan 
settings, this feature is especially useful. The default is 0. The value ranges from 0 to 30 
seconds. 
 
 

Note:  
Within the specified timeout period, if you load your document to the feeder, the scanner 
starts scanning automatically. 
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6.6 The Preview Tab 

 
The Preview tab allows you to preview (a low-resolution scan) your image before final scan. 
This preview image lets you allocate your scan area. You can choose your scan area by the 
“Scan Area” drop down list box or placing your cursor on the Display window and dragging it 
diagonally on the Display window. Then, a red rectangle box will appear to indicate the 
selected area. 
 
Note: If you choose “Automatic Cropping” on the “Paper Tab”, then to select a scan area on 
the Preview tab is not allowed. 
 

 
 

The Preview Tab 
 
 
 
 

The Display 
Window 
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6.7 The Options Tab 

 
The Options tab allows you to set following additional image processing settings.  
 

 

The Option tab dialog box 
 
 
 
Image 
Control 
Option 

Check the Mirror box if you wish to reverse the right and left side of your 
image. 

 
Original 

 

 
The Mirror Effect 
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Background 
Setting 

This option allows you to set your scan background. Choice: White 
Background, Black Background. 

Note: For a sheet-fed scanner with an auto document feeder, this option 
is currently available only in the “Auto crop” mode. For a scanner with a 
flatbed platen, this option is available either in the “Auto crop” or the 
“Fixed to Transport” mode.  
 

 
White Background 

 

 
Black Background 
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6.8 The Setting Tab 

The Setting tab allows you to set the following settings: 

 

The Setting tab dialog box 
 

Cache 

 

Mode: None, Page Number, Memory Size.  

This option allows you to assign a specified memory size from the 
available RAM to process the image data. By specifying a smaller 
memory size, you can free more memory for other applications 
you are running. By specifying a larger memory size, you can 
have more memory to process the image data especially when 
you have a large amount of documents needed to be scanned.  

You can also specify your memory size by the page number. For 
your information, an A4 color document scanning at 300 dpi 
consumes approximates 24MB. 

Image Count 

When the selected cache mode is “none”, the image count option 
allows you to assign number of pages you need to scan. For 
example, if you wish to scan the first two pages, simply move the 
page slider to 2, and the scan action will be stopped when the 
scanning of the first two pages have been completed. 

Show 

Scanning 

Progress 

Check and the scanning progress bar will be shown during 

scanning. 

Show Warning 

Message 

Check to show the warning messages such as “ADF pad count 

exceeds 50,000 scans (the number varies based on type of 

scanner). Please replace the ADF pad and reset the pad count.” 
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6.9 The Information Tab  

 
The Information tab displays the following system and scanner information.  

 
 

The Information tab dialog box 
 

The “Report” button： 

If you encounter any error message while using the scanner, click the Report button. A 
report.txt file (C:\IRIScan Pro Wifi) will be generated. Please send this file to the nearest 
service center for trouble shooting.  

 
The “Reset Pad Count” button： 

After scanning approximately 10,000 pages through the Auto Document Feeder (ADF), the 
ADF pad may be worn out and you may experience problems with document feeding. In this 
case, it is highly recommended to replace the ADF pad with a new one. (Please refer to the 
manual for proper replacing procedure.) For ordering the ADF pad, please consult your 
nearest dealer. After replacing the ADF pad, click the “Reset Pad Count” button to reset the 
pad count.  

 

The “Reset Roller Count” button： 

After scanning approximately 100,000 pages through the ADF, the ADF roller may be worn 
out and you may experience problems with document feeding. In this case, it is highly 
recommended to replace the ADF roller with a new one. (Note the replacement of the ADF 
roller has to be performed only by authorized service center. Therefore, please return your 
scanner for roller replacement.)  After replacing the ADF roller, click the “Reset Roller 
Count” button to reset the roller count.  
 

 



User Guide 

 7-1 

7. Maintenance 

 
 
 

7.1 Clean the Scanner Glass, Separation Pad and Rollers 

If the scanned images contain streaks or scanned documents become dirty, the scanning 
glass, separation pad and roller inside the scanner are likely to be dirty. Clean them 
periodically.  
 
Use only the recommended or supplied tool to clean the scanner and feeder dock. 

 
Cleaning steps:  
 
1. Open the feed tray. 
 

 
 
2. Open the feeder cover. 
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3. Wipe the separation pad, rollers and the glass with the included cleaning cloth. 
 

 
 
 
 

Note: 
 Adding some isopropyl alcohol (95%) on the cleaning cloth is more efficient when 

cleaning the rollers. 

 Do not use any solvents or corrosive liquid (i.e., alcohol, kerosene, etc.) to clean any 
part of the scanner, otherwise the plastic material will be permanently damaged. 

 Make sure the surface of the document or photo doesn’t have any paper clips, etc. or 
this could damage the scanner glass lens. 

 



User Guide 

 7-3 

 

7.2 Calibrate the Scanner 

Calibrate only if the scanned image looks fuzzy, the color looks abnormal (e.g., darker than 
normal), after more than 8,000 scans, or the scanner has been stored without use for a long 
time. The calibration process resets the Contact Image Sensor to resume its color and 
sharpness precision.  
 
1. Open the document extension plate. 

2. Make sure the Document Guides are unfolded as shown in the image (1). 

 

3. Hold the edges of the calibration sheet (which you find in the product box) and insert it 
with the text FACING DOWN (2).  

4. Align it to the right and make sure the white area is fed first (3). 

5. Turn on the scanner by moving the Power switch to the [ON] position. 

 

6. To enter the calibration mode, press and hold the [Color/BW] until [CAL] is displayed 
on the screen and the [Scan] LED flashes in green, indicating you are in calibration 
mode.  

 

7. Press the [Scan] button. The calibration sheet will be fed through. 

8. When the calibration process is finished, [OK] is displayed on the screen. 
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Notes: 

 If the calibration process failed, the red led flashes and [E19] is displayed on the 
screen. Power off the scanner and repeat the calibration. 

 To keep the calibration sheet feeding straight, slightly the top edge of the sheet when 
the sheet begins to feed through. 

Calibrate the Scanner in PC mode: 

Alternatively, you may also follow these steps to calibrate the scanner in PC mode. 

1. Follow step 1 to 5 as described above. 

2. Switch to PC mode by pressing the “SD/PC/Wifi” button on the scanner until the LCD 
screen shows “PC”. 

3. Start Capture Tool by choosing Start>All Programs>IRIS IRIScan Pro Wifi 
Scanner>Capture Tool. 

4. Select “IRIScan Pro Wifi” as your scanner model. The main window of Capture Tool 
will be displayed. 

5. Choose the “Setting” tab and then the “Calibration” button. 

6. The calibration card will be fed through and LCD screen shows “Cal”. 

7. After the calibration process is finished, [OK] will be displayed on the screen. 

Warning:  
If the calibration process failed, the Red LED will be flashing and [E19] will be displayed on 
the screen. Power off the scanner and then repeat the calibration step again. 

 

Warning: 
 Do not interrupt the calibration sequence or try to shut off the device while it is 

calibrating. If you stop the calibration before it has completed, a calibration error may 
occur. As a result, you will have to power off the unit and repeat the instructions in this 
section.  

 Calibrate the scanner only when color of the scanned image looks abnormal.  

 Keep the calibration sheet from dust and debris. Any dirt may make the calibration chart 
invalid or impact the calibration result. 

 Use only the included calibration sheet to calibrate the scanner. 
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7.3 Replace the Feed Roller  

The feed roller and separation pad inside the scanner wear with scanning. If the feed roller 
and separation pad are worn, documents may not feed correctly and paper jams may occur. 
When document feed performance deteriorates, replace the feed roller and separation pad. 
 

Note: 
It is recommended to replace the feed roller or separation pad when the total number of 
pages of documents fed in the scanner exceeds one of the following quantities: 
Feed Roller: 100,000 sheets 
Separation Pad: 10,000 sheets 

 
 
Follow these steps to replace the separation pad and feed roller. 
 
To replace the Feed Roller, 
 
1. Open the feed tray. 

 
 

 
2. Open the feeder cover. 
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3. Open the roller cover. 
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4. Slide the feed rollers to the right. 
 

    
 
5. Remove the feed rollers. 
 
6. Attach the feed rollers. Insert the left end of the shaft to the notch. A snap-in sound 

could be heard. 
 

 
 
7. Completely close the roller cover so that it clicks into place. 

 
8. Close the feeder cover. 
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7.4 Replace the Separation Pad  

To replace the Separation Pad, 
 
1. Open the feed tray. 
 

 
 

2. Open the feeder cover. 
 

 
 

3. Press two arms of the separation pad inwardly with two fingers () and lift it up 

() to remove the separation pad. 
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4. Hold two arms of the separation pad with two fingers and attach the new separation 

pad to the scanner. 
 
 

 
 
5. Close the feeder cover. 
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8. Troubleshooting 

 
 
 
 
8.1 Clear a paper jam 

 

In the event of a paper jam, follow the procedures below to remove the paper: 
 

1. Gently open the feeder cover. 

 

2. Carefully pull the paper out of the feed tray. 

 

 

 

 

3. Close the feeder cover. Your Scanner is now ready to use. 
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8.2 Error Conditions 

If there is error during scanning, the LED light will be flashing in red color and error codes 
will be displayed. Refer to the following table to clear the error conditions. 

 
 

Error 
Code/Meaning 

Cause How to restore 

E03 
Storage error 
 
 

Storage is full; can not save 
image to storage device. 

Storage device not recognized. 

Free more space or insert a new 
SD card. 

Format your storage device.  

E04 

Paper jam 

1. Original has become stuck in 
the feeder. 

2. Original exceeds max. length 
[300 dpi: 36” (914mm), 600 
dpi: 14” (356mm)] 

Open the feeder cover and pull 
the original out of the feeder. 

E05 

No image scanned 

No scan data detected. 

 

Wait until error disappears. 

 

E06 

Cover opens 
Feeder cover opens. Close the feeder cover. 

E08 
Low battery 

Battery power getting low. Recharge the battery.  

E19 

Calibration Fails 

Internal check failed and found 
calibration data error 

Recalibrate the scanner (see the 
“Calibrate Scanner” section. 

 

 

* Warning: 
If "low battery" is indicated on the LCD display, it is recommended to recharge the battery to 
prevent possible incomplete scanned images or other operational problems. 
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8.3 Frequently asked questions and answers 

 

General: 

 

Q： Paper becomes jammed or multi-fed. 

A： 1. Flatten the corners and edges of your documents. 

2. Thoroughly fan your documents before loading them into the 
scanner. Document might stick together because of static 
electricity. 

3. Reduce the number of pages that you load into the scanner at 
one time. 

 
 

Q： Paper becomes skewed in the scanner. 

A： 
1. Align the document guides to fit the documents as closely as 

possibly and place the documents so that they feed in 
straight. 

2. Check the condition of the feeding roller. If necessary, follow 
the cleaning directions in Section 5.1 and perform the 
cleaning.  

 
 

Q： Why does not my scanner turn on? 

A： The batteries may not enough power or may not be inserted 
correctly. 

 
 

Q： Why doesn’t my computer recognize my scanner when it’s 
connected via USB cable? 

A： Make sure the cable connection is correct and secure. Restart the 
computer if necessary. 

 

Q： Why there is a red or gray background with lines on my 
scanned image? 

A： The scanner does not enough power to perform a scan. Charge 
your batteries and restart the scan.  
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Q： Why there are strange lines on the scanned document? 

A： 
Please check the following:  

1. Are there scratches on the original or is the original clean？ 

2. Remove any stains or dust from the original before scanning. 

3. Clean the rollers and glass with the included cleaning cloth. 
(Refer to the section “Cleaning the Rollers and Glass)) 

 
 

Q： Should the scanner feel warm to the touch? 

A： It is normal for the scanner to emit a small amount of heat after 
prolonged use. However, if there are strange odors coming from 
the scanner or the scanner feels a little bit hot to the touch, turn 
the scanner off immediately. 

 
 

SD Mode: 
 

Q： The image can not be saved into the memory card while 
scanning? 

A：  
Make sure you have a SD card inserted correctly, and that it has 
adequate space. 
 

 
 

PC Mode: 
 

Q： Why does my scanned image always come out too dark? 

A： 1. Please adjust the screen settings to SRGB. 

2. Please adjust the brightness settings on the screen from 
application software. 

 
 

Q： When I choose optical resolution to be 600 dpi, the "auto 
crop" and "deskew" functions will be disabled. 

A： Since to perform auto crop and deskew consumes a great deal of 
system memory, it is suggested if you wish to perform "auto crop" 
and "deskew" functions, please choose your optical resolution to 
be smaller than 600 dpi to prevent a error message. 
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Wifi Mode: 
 

Q： Why can’t I see the Scanner’s Wifi Network ID [SSID]? 

A： Make sure you have pressed the [Wifi] button and the Wifi icon is 
displayed on the LCD screen. If Wifi Access Point is still in 
countdown mode, wait until the blue Wifi indicator light turned 
solidly on. 

 
 

Q： Will the battery power get used up faster when Wifi mode is 
on? 

A： Yes. When Wifi mode is on, the scanner does not time-out and 
automatically turn off like it does normally. Therefore, it is 
recommended to turn off the Wifi mode when images have been 
downloaded onto your computer. 

 
 

Q： Why can’t I connect to my email or other web related 
locations/programs after disconnecting from the scanner 
Wifi network?  

A： To resume your normal Wifi connection, be sure to re-connect your 
computer, tablet or phone to your usual local Wifi network when 
you are finished with your scanner connection. 

 
 

Q： My browser can’t access the I.R.I.S. PhotoView window and 
the I.R.I.S. PhotoView slideshow window?  

A： It is probably the proxy settings has been enabled in your device’s 
browser or the URL address of your default page contains “https”. 
In these cases, please enter http://www.google.com or 
http://10.10.100.1 on the URL address. The I.R.I.S. PhotoView 
page will be displayed. 

 
 

Q： Why are my files are no longer accessible through the Wifi 
connection?  

A： If using a SD card, do not remove the SD card while you are 
connected via Wifi. If you have done so, you must restart the 
scanner to reconnect with Wifi. 

 

http://www.google.com/
http://10.10.100.1/
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Q： Why can’t I see my recently scanned images?  

A： Click the “Refresh” button of your browser or delete all browser 
session cache. 

 
 

Q： Why are my files no longer accessible through the Wifi 
connection?  

A： If using a SD card, do not remove the SD card while you are 
connected via Wifi. If you have done so, you must restart the 
scanner to reconnect with Wifi. 

 
 

Q： Why can I still see scanned images deleted from Internet 
Explorer? 

A： Certain Internet Explorer 7 or 8 SP2 has particular problem to 
delete selected files and they reappear on SD Card. You can delete 
through LCD Preview and Delete or through PC-connect to delete 
physical files using Windows Explorer. 

 
 

Q： Are all browsers supported? 

A： All browsers have different configurations. The following browsers 
have been tested. 

Browser Name Version 

Internet Explorer 7.0, 8.0, & 9.0 

Chrome 19.0 PC and Mac  

slideshow may not work depending on 
browser’s settings 

Safari 6.0 Mac, 5.1.7 PC 

iOS Safari 5.1 or later for iPhone, iPad, or iPod 

Android WebKit 2.3, 3.01 or later for Android Tablets 
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8.4 Technical Service  

Before contact I.R.I.S., please prepare the following information: 
 

 Scanner serial & revision number (located on the bottom of the scanner); 
 Hardware configuration (e.g., your host CPU type, RAM size, free disk space, display card, 

interface card); 
 

 
I.R.I.S. s.a. 

Rue du Bosquet 17 
Louvain La Neuve 1348 

Web Site: http://www.iriscorporate.com  

Support: http://www.irislink.com/support 

 
  

 
 

 

 
 

http://www.iriscorporate.com/
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9. Specifications 
 
 
 
 
Specifications are subject to change without notice. 

 
General Specifications: 

 

Item Description 

Regulatory model number IRIScanTM Pro 3 Wifi 

Image Technology Contact Image Sensor (CIS) 

Built-In Memory 128M 

Scanner Display 1.2” TSN LCD 

Max. Document Size 8.5” x 14” (216 x 356 mm) 

Long Page Mode 36” (Available for 300 dpi only) 

Min. Document Size 3.5” x 2” (88 x 50 mm) 

Document Weight 60 ~ 107 g/m² ( 16 to 28 lb ) 

Card Weight <1.00mm 

Auto power off 3 minutes 

Output File Format JPEG/PDF  

Resolution 300 dpi /600 dpi  

ADF Capacity 8 pages 

Support Operating System Windows XP / Vista / 7 /8, Mac OS 10.5 or later 

Interfaces 
Memory Card SD card 

USB Micro USB port compatible with the USB 2.0  

USB Power  5Vdc, 500mA 

Battery Rechargeable Li-ion battery AP-120 
(APACK)/CB-PD(NP-120) (City Bright) 
3.7V, 1700mAh 

Battery Life 200 pages (A4, Color, 300 dpi) 

Net Weight 800 g (1.8 lb) 

Dimensions（WxLxH） 
11.6” x 3.2” x 1.6” 

(295 x 81 x 41 mm) 

Operating Environment 
Temperature:10ºC ~ 35ºC (50ºF~95ºF) 
Humidity: 10%~85% RH 
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Wifi Specifications:  
 

 

Standard IEEE 802.11 b/g/n standards compliant 

Wireless LAN 1T1R Mode 

Frequency Range 2.400 ~ 2.4835GHz ( subject to local regulations) 

Number of 
Selectable 
Channels 

802.11n: 20MHz/40MHz 

802.1
1b/g: 

USA, Canada (FCC):11 channels (2.412GHz~2.462GHz) 

Europe (CE): 13 channels (2.412GHz~2.472GHz) 

Japan (TELEC): 14 channels (2.412GHz~2.4835GHz) 

Data Rate 

802.11n: up to 150Mbps 

802.11b: 1, 2, 5,5, 11Mbps 

802.11g: 6, 9, 12, 18, 24, 36, 48, 54Mbps 

Transmit 
Power(EIRP) 

11n HT40 MCS7 : +13 dBm 

11g OFDM: +15 dBm 

11b CCK: +18 dBm 

Security WEP 64/128, TKIP, WPA, WPA2 mixed,802.1x and 802.11i 
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